
       
Installing & Setup the Driver 
This section explains how to install the drivers needed for connecting the 
DR-880 to a computer, and make the necessary settings.

Installing & Setting Up the Driver (Windows) ..............................  (p. 2)

Installing & Setting Up the Driver (Macintosh) ............................  (p. 13)

* Microsoft and Windows are registered trademarks of Microsoft Corporation.

* The screen shots in this document are used in compliance with the guidelines of the Microsoft Corporation.

* Windows® is known officially as: “Microsoft® Windows® operating system.”

* Apple and Macintosh are registered trademark of Apple Computer, Inc.

* MacOS is a trademark of Apple Computer, Inc.

* OMS is a registered trademark of Opcode Systems, Inc.

* FreeMIDI is a trademark of Mark of the Unicorn, Inc.

What is a USB MIDI driver?
A “USB MIDI driver” is software that transfers MIDI data between the DR-880 and application 
software running on your computer, when your computer and the DR-880 are connected by a USB 
cable. The driver sends MIDI data from your application to the DR-880, and from the 
DR-880 to your application.

Copyright © 2004 BOSS CORPORATION
All rights reserved. No part of this publication may be reproduced in any form without the written permission of BOSS CORPORATION. 
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Installing & Setting Up the 
Driver (Windows)
Driver Installation

■ Windows XP users

1
With the DR-880 disconnected, start up Windows.

Disconnect all USB cables except for a USB keyboard and USB mouse (if 
used).

2
Open the System Properties dialog box.

1. Click the Windows Start menu, and from the menu, select Control 
Panel.

2. In “Pick a category”, click “Performance and Maintenance”.

3. In “or pick a Control Panel icon”, click the System icon.

fig.2-1

3
Click the Hardware tab, and then 
click [Driver Signing].

Open the Driver Signing Options 
dialog box.

4
Make sure that “What action do 
you want Windows to take?” is 
set to “Ignore”.

If it is set to “Ignore”, simply click 
[OK].
If it is not set to “Ignore”, make a 
note of the current setting 
(“Warn” or “Block”). Then change 
the setting to “Ignore” and click 
[OK].

The installation procedure will differ depending on your system.
Please proceed to one of the following sections, depending on the system you use.

• Windows XP users ............................................... (p. 2)
• Windows 2000 users ............................................ (p. 6)
• Windows Me/98 users ........................................ (p. 9)

If you are using Windows 
XP Professional, you must 
log on using a user name 
with an administrative 
account type (e.g., 
Administrator). For details 
on user accounts, please 
consult the system 
administrator of your 
computer.

Depending on how your 
system is set up, the 
System icon may be 
displayed directly in the 
Control Panel (the Classic 
display). In this case, 
double-click the System 
icon.

If you changed “What 

action do you want 

Windows to take?” in 
step 4, you must restore 
the previous setting after 
you have installed the 
driver. 
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Installing & Setting Up the Driver (Windows)

                                                               
5
Click [OK] to close the System Properties dialog box.

6
Exit all currently running software (applications).

Also close any open windows. If you are using virus checking or similar 
software, be sure to exit it as well.

7
Prepare the CD-ROM.

Insert the CD-ROM into the CD-ROM drive of your computer.

8
Click the Windows start button. From the menu that appears, select 
“Run...”. 

Open the “Run...” dialog box.
fig.2-3_30

9
In the dialog box that appears, 
input the following into the 
“Open” field, and click [OK].

D:\DRIVER\XP2K\SETUPINF.EXE

* The drive name “D:” may be different for your system. Specify the drive name of your 
CD-ROM drive.

10
The SetupInf dialog box will appear.

You are now ready to install the driver.

11
Use the USB cable to connect the DR-880 to your computer.

* Before you connect the USB cable, you must first set the DR-880’s USB mode to 
“MIDI”, and switch off the DR-880’s power.

1. With the power switch turned OFF, connect the AC adaptor to the 
DR-880.

2. Connect the AC adaptor to an electrical outlet.

3. Use the USB cable to connect the DR-880 to your computer.

For details on how to set 
the USB mode, refer to the 
“DR-880 owner’s manual.”

Once the connections have 
been completed, turn on 
power to your various 
devices in the order 
specified. By turning on 
devices in the wrong 
order, you risk causing 
malfunction and/or 
damage to speakers and 
other devices.
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Installing & Setting Up the Driver (Windows)

                                     
12
Set the DR-880’s power switch to the ON position.

Near the task bar, your computer will indicate “Found New Hardware”. 
Please wait.

13
The Found New Hardware Wizard will appear.

Make sure that the screen indicates “BOSS DR-880”, select“Install from a 
list or specific location (Advanced)”, and click [Next].

fig.2-7

14
The screen will indicate “Please 
choose your search and 
installation options”.

Select “Don’t search. I will 
choose the driver to install”, and 
click [Next].

15
Make sure that the “Model” field indicates “BOSS DR-880”, and click 
[Next]. Driver installation will begin. 

fig.2-9_30

16
The Insert Disk dialog box will appear. 

Click [OK].

This unit is equipped with 
a protection circuit. A brief 
interval (a few seconds) 
after power up is required 
before the unit will operate 
normally.

If the screen indicates 
“Windows can perform 

the same action each 

time you insert a disk or 

connect a device with 

this kind of file,” click 
[Cancel]. 

If the “What action do you want Windows to take?” setting was not set to “Ignore”, a 
“Hardware Installation” dialog box will appear.

If “What action do you want Windows to take?” is set to “Warn”

1. Click [Continue Anyway].

2. Continue the installation.

If “What action do you want Windows to take?” is set to “Block”

1. Click [OK].

2. When the “Found New Hardware Wizard” appears, click [Finish].

3. Return to step 1 (p. 2) and re-install the driver from the beginning of the procedure.

The Insert Disk dialog 
may not appear. In that 
case, proceed to step 17.
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Installing & Setting Up the Driver (Windows)
17
The Files Needed dialog box will appear. 

Input the following into the “Copy files from” field, and click [OK]. 

D:\DRIVER\XP2K

* The drive name “D:” may be different for your system. Specify the drive name of your 
CD-ROM drive.

18
The Found New Hardware Wizard will appear.

Make sure that the display indicates “BOSS DR-880”, and click [Finish].
Wait until “Found New Hardware” appears near the taskbar.

19
When driver installation has been completed, the System Setting Change 
dialog box will appear.

Click [Yes]. Windows will restart automatically.

If you changed “What action do you want Windows to take?”
If you changed the What action do you want Windows to take? setting, restore the 
original setting after Windows restarts.

1.  If you are using Windows XP Professional, log on to Windows using the user name 
of an administrative account (e.g., Administrator).

2. Click the Windows start menu, and from the menu, select Control Panel.

3. In “Pick a category”, click “Performance and Maintenance”.

4.  In “or pick a Control Panel icon”, click the System icon. The System Properties 
dialog box will appear.

* Depending on how your system is set up, the System icon may be displayed directly in the Control 
Panel (the Classic display). In this case, double-click the System icon.

5. Click the Hardware tab, and then click [Driver Signing]. The Driver Signing Options 
dialog box will appear.

6. Return the What action do you want Windows to take? setting to the 
original setting (either “Warn” or “Block”), and click [OK].

7. Click [OK]. The System properties dialog box will close.

Next, you need to make the driver settings.
(➔ MIDI input and output destinations (p. 11))
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■ Windows 2000 users

1
With the DR-880 disconnected, start up Windows.

Disconnect all USB cables except for a USB keyboard and USB mouse (if 
used).

2
Log on to Windows as a user with administrative privileges (such as 
Administrator).

3
Open the System Properties dialog box.

Click the Windows Start button, and from the menu that appears, select 
Settings | Control Panel. In Control Panel, double-click the System icon.

fig.2-12

4
Click the Hardware tab, and then 
click [Driver Signing].

Open the Driver Signing Options 
dialog box.

5
Make sure that “File signature 
verification” is set to “Ignore”.

If it is set to “Ignore”, simply click 
[OK].
If it is not set to “Ignore”, make a 
note of the current setting 
(“Warn” or “Block”). Then change 
the setting to “Ignore” and click 
[OK].

6
Close the System Properties dialog box.

Click [OK].

7
Exit all currently running software (applications).

Also close any open windows. If you are using virus checking or similar 
software, be sure to exit it as well.

8
Prepare the CD-ROM.

Insert the CD-ROM into the CD-ROM drive of your computer.

If you changed the “File 

signature verification” 
setting in step 5, you must 
restore the previous setting 
after you have installed the 
driver.  
6
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9
Click the Windows Start button. From the menu that appears, select 
“Run...”.

Open the “Run...” dialog box.
fig.2-14_40

10
In the dialog box that appears, 
input the following into the 
“Open” field, and click [OK].

D:\DRIVER\XP2K\SETUPINF.EXE

* The drive name “D:”  may be different for your system. Specify the drive name of 
your CD-ROM drive.

11
The SetupInf dialog box will appear.

You are now ready to install the driver.

12
Use the USB cable to connect the DR-880 to your computer.

* Before you connect the USB cable, you must first set the DR-880’s USB mode to 
“MIDI”, and switch off the DR-880’s power.

1. With the power switch turned OFF, connect the AC adaptor to the 
DR-880.

2. Connect the AC adaptor to an electrical outlet.

3. Use the USB cable to connect the DR-880 to your computer.

13
Set the DR-880’s power switch to the ON position.

For details on how to set 
the USB mode, refer to the 
“DR-880 owner’s manual.”

Once the connections have 
been completed, turn on 
power to your various 
devices in the order 
specified. By turning on 
devices in the wrong 
order, you risk causing 
malfunction and/or 
damage to speakers and 
other devices.

This unit is equipped with 
a protection circuit. A brief 
interval (a few seconds) 
after power up is required 
before the unit will operate 
normally.

If the “File signature verification” setting was not set to “Ignore”, a “Digital 
Signature Not Found” dialog box will appear.

If “File signature verification” is set to “Warn” 

1. Click [Yes].

2. Continue the installation.

If “File signature verification” is set to “Block”

1. Click [OK].

2. When the “Found New Hardware Wizard” appears, click [Finish].

3. Return to step 1 (p. 6) and re-install the driver from the beginning of the 
procedure.
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14
The Insert Disk dialog box will appear.

Click [OK].

15
The Files Needed dialog box will appear.

Input the following into the “Copy files from” field, and click [OK]. 

D:\DRIVER\XP2K

* The drive name “D:” may be different for your system. Specify the drive name of your 
CD-ROM drive.

16
The “Found New Hardware Wizard” may be displayed.

Verify that “BOSS DR-880” is displayed, and click [Finish].

17
The System Settings Change dialog box may appear. 

Click [Yes]. Windows will restart automatically.

If the Insert Disk dialog 
box does not appear, 
please read The “Insert 

Disk” dialog box does 

not appear (p. 22).

If you changed “File signature verification”
If you changed the “File signature verification” setting, restore the original setting after 
Windows restarts.

1. After Windows restarts, log in to Windows as a user with administrative privileges, 
(such as Administrator).

2. In the Windows desktop, right-click the My Computer icon, and from the menu that 
appears, select Properties. The System Properties dialog box will appear.

3. Click the Hardware tab, and then click [Driver signature]. The Driver Signing 
Options dialog box will appear.

4. Return the “File signature verification” setting to the original setting (either “Warn” 
or “Block”), and click [OK].

5. Click [OK]. The System properties dialog box will close.

Next, you need to make the driver settings.
(➔ MIDI input and output destinations (p. 11))
8



Installing & Setting Up the Driver (Windows)
■ Windows Me/98 users

1
With the DR-880 disconnected, start up Windows.

Disconnect all USB cables except for a USB keyboard and USB mouse (if 
used).

2
Exit all currently running software (applications).

Also close any open windows. If you are using virus checking or similar 
software, be sure to exit it as well.

3
Prepare the CD-ROM.

Insert the CD-ROM into the CD-ROM drive of your computer.

4
Click the Windows Start button. From the menu that appears, select 
“Run...”.

Open the “Run...” dialog box.
fig.2-19a_30

5
In the dialog box that appears, 
input the following into the 
“Open” field, and click [OK].

D:\DRIVER\ME98\SETUPINF.EXE

* The drive name “D:” may be different for your system. Specify the drive name of your 
CD-ROM drive.

6
The SetupInf dialog box will appear.

You are now ready to install the driver.

7
Use the USB cable to connect the DR-880 to your computer.

* Before you connect the USB cable, you must first set the DR-880’s USB mode to 
“MIDI”, and switch off the DR-880’s power.

1. With the power switch turned OFF, connect the AC adaptor to the 
DR-880.

2. Connect the AC adaptor to an electrical outlet.

3. Use the USB cable to connect the DR-880 to your computer.

For details on how to set 
the USB mode, refer to the 
“DR-880 owner’s manual.”

Once the connections have 
been completed, turn on 
power to your various 
devices in the order 
specified. By turning on 
devices in the wrong 
order, you risk causing 
malfunction and/or 
damage to speakers and 
other devices.
9



Installing & Setting Up the Driver (Windows)
8
Set the DR-880’s power switch to the ON position.

9
The driver will be installed automatically.

10
In the dialog box, click [OK].

* If a message recommends that you restart Windows, restart Windows as directed.

This unit is equipped with 
a protection circuit. A brief 
interval (a few seconds) 
after power up is required 
before the unit will operate 
normally.

Next, you need to make the driver settings.
(➔ MIDI input and output destinations (p. 11))
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Settings
■ MIDI input and output destinations

Windows XP/2000/Me users

1
Open Control Panel.

Click the Windows Start button, and from the menu that appears, select 
Settings | Control Panel. 

Windows XP
Click the Windows start button, and from the menu that appears, select 
Control Panel. 

2
Open the Sounds and Audio Devices Properties dialog box (or in 
Windows 2000/Me, Sounds and Multimedia Properties).

Windows XP
In “Pick a category”, click “Sound, Speech, and Audio Devices”. 
Next, in “or pick a Control Panel icon”, click the sounds and Audio 
Devices icon.

Windows 2000/Me
In Control Panel, double-click the Sounds and Multimedia icon to open 
the “Sounds and Multimedia Properties” dialog box.

3
Click the Audio tab.

fig.2-28_30

4
For MIDI music playback, click the ▼ 
located at the right of [Default device] (or 
in Windows 2000/Me, [Preferred 
device]), and select the BOSS DR-880 
from the list that appears.

5
Close the Sounds and Audio Devices Properties dialog box. 
Click OK to complete the settings.

Depending on how your 
system is set up, the 
Sounds and Audio 

Devices icon may be 
displayed directly in the 
Control Panel (the Classic 
display). In this case, 
double-click the Sounds 

and Audio Devices icon.

Select the appropriate 
MIDI device for your 
system. You do not 
necessarily have to select 
BOSS DR-880.
11
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6
Make MIDI device settings on your sequencer software. For details on the 
Select the MIDI OUT/IN device to the BOSS DR-880.

Windows 98 users

1
Open Control Panel.

Click the Windows Start button, and from the menu that appears, select 
Settings | Control Panel. 

2
Open the Multimedia Properties dialog box.

In Control Panel, double-click the Multimedia icon to open the  “Multimedia 
Properties” dialog box.

fig.2-29_30

3
Click the MIDI tab.

4
Set “MIDI output”.

Select [Single instrument], and select 
the BOSS DR-880 from the list that 
appears.

5
Close the Multimedia Properties dialog box. 
Click OK to complete the settings.

6
Make MIDI device settings on your sequencer software. 

Select the MIDI OUT/IN device to the BOSS DR-880.

For details on MIDI device 
settings, refer to the 
owner’s manual for the 
software you are using.

This completes driver settings.

Select the appropriate 
MIDI device for your 
system. You do not 
necessarily have to select 
BOSS DR-880.

For details on MIDI device 
settings, refer to the 
owner's manual for the 
software you are using.

This completes driver settings.
12



Installing & Setting Up the 
Driver (Macintosh)
Mac OS 9 users

■ Installing the driver
Use either OMS or FreeMIDI as the MIDI driver.

The included DR-880 driver is an add-on module for using the DR-880 with 
OMS or FreeMIDI.

* Either OMS or FreeMIDI must be installed in your Macintosh, as appropriate for 
the sequencer software you are using.

* Disconnect the DR-880 from the Macintosh before you perform the installation.

Use the following procedure to install the DR-880 driver.

1
Exit all currently running software (applications).

If you are using a virus checker or similar software, be sure to exit this as well.

2
Prepare the CD-ROM.

Insert the CD-ROM into the CD-ROM drive.

The installation procedure will differ depending on your system.
Please proceed to one of the following sections, depending on the system you use.

• Mac OS 9 users...................................................... (p. 13)
• Mac OS X users ..................................................... (p. 19)

OMS can be found in the 
OMS 2.3.8 E folder within 
the OMS folder of the 
CD-ROM. If you would 
like to know more about 
OMS, refer to 
OMS_2.0E_Mac.pdf 
which can be found in the 
same folder.

If a DR-880 is already connected to your Macintosh when you install the driver, a message like the 
following will appear when the Macintosh is started up. Perform the steps described below as 
appropriate for the message that is displayed.

If the screen indicates:
“Driver required for USB device ‘unknown device’ is not available. Search for driver 
on the Internet?” ➔ click [Cancel].

If the screen indicates:
“Software required for using device ‘unknown device’ cannot be found. Pl ease refer 
to the manual included with the device, and install the necessary software”.

➔ click [OK].
13



Installing & Setting Up the Driver (Macintosh)
3
Double-click the DR-880 Driver-E Installer icon (found in the Driver E (Mac 
OS 9)  folder of the CD-ROM) to start up the installer.

4
Verify the Install Location, and click [Install].

fig.3-2_40

5
If a message like the following is 
displayed, click [Continue]. 

The other currently running 
applications will exit, and 
installation will continue.

6
A dialog box will indicate Installation completed. 

Click [Restart] to restart your Macintosh.

■ Setting the driver

OMS settings

1
Use the USB cable to connect the DR-880 to your computer.

* Before you connect the USB cable, you must first set the DR-880’s USB mode to 
“MIDI”, and switch off the DR-880’s power.

1. With the power switch turned OFF, connect the AC adaptor to the 
DR-880.

2. Connect the AC adaptor to an electrical outlet.

3. Use the USB cable to connect the DR-880 to your computer.

2
Set the DR-880’s power switch to the ON position.

fig.3-3

3
From the CD-ROM, drag the Driver E (Mac OS 9) - OMS 
Setting folder to the hard disk of your Macintosh to copy 
it.

fig.3-4

4
In the Opcode-OMS Application folder where you 
installed OMS, double-click OMS Setup to start it up.

For details on how to set 
the USB mode, refer to the 
“DR-880 owner’s manual.”

Once the connections have 
been completed, turn on 
power to your various 
devices in the order 
specified. By turning on 
devices in the wrong 
order, you risk causing 
malfunction and/or 
damage to speakers and 
other devices.

This unit is equipped with 
a protection circuit. A brief 
interval (a few seconds) 
after power up is required 
before the unit will operate 
normally.
14



Installing & Setting Up the Driver (Macintosh)
fig.3-5_35

5
If a dialog box like the one shown 
here appears, click [Turn It Off]. A 
confirmation dialog box will then 
appear, so click [OK].

fig.3-6_35

6
The Create a New Studio Setup 
dialog box will appear. Click 
[Cancel]. 
If you accidentally clicked [OK], 
click [Cancel] in the next screen.

fig.3-8_35

7
Choose “Open” from the File 
menu.

From the Setting folder that you 
copied in step 3, select the DR-880 
file, and click [Open].
A screen like the one shown here 
will appear.

fig.3-9_35

8
From the Edit menu, select OMS 
MIDI Setup. 

In the OMS MIDI Setup dialog box 
that appears, check Run MIDI in 
background, and click [OK].

We recommend that you 
turn off AppleTalk, by 
selecting Chooser from 
the Apple menu.
15
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fig.3-10

9
From the File menu, choose Make 
Current. 

If you are unable to select Make 
Current, it has already been 
applied, and you may continue to 
the next step.

10
Verify that MIDI transmission and reception can be performed correctly. 
From the Studio menu, choose Test Studio.

fig.3-22_50

When you move the mouse cursor 
near the DR-880 icon, the cursor 
will change to a � shape.
Click the DR-880 icon shown in the 
diagram at the right. If you hear 
sound from the DR-880, the settings 
have been made correctly.

11
Exit OMS Setup.

From the File menu, choose [Quit]. If the AppleTalk confirmation dialog box 
appears, click [OK] to close the dialog box.

12
Make MIDI device settings on your sequencer software. 

Select the MIDI OUT/IN device to the BOSS DR-880.

A diamond mark (◊) indicate in the settings are enabled.

For details on connecting a 
MIDI sound module, refer 
to the owner’s manual for 
your MIDI sound module.

For details on MIDI device 
settings, refer to the 
owner's manual for the 
software you are using.

This completes the series of steps needed to connect the DR-880 to the 
Macintosh, install the MIDI driver, and make the driver settings.
16
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■ FreeMIDI settings

1
Use the USB cable to connect the DR-880 to your computer.

* Before you connect the USB cable, you must first set the DR-880’s USB mode to 
“MIDI”, and switch off the DR-880’s power.

1. With the power switch turned OFF, connect the AC adaptor to the 
DR-880.

2. Connect the AC adaptor to an electrical outlet.

3. Use the USB cable to connect the DR-880 to your computer.

2
Set the DR-880’s power switch to the ON position.

3
From the CD-ROM, copy the Driver E (Mac OS 9) – FreeMIDI Setting 
folder onto the hard disk of your Macintosh.

4
Open the FreeMIDI Applications folder from the location into which you 
installed FreeMIDI, and double-click the FreeMIDI Setup icon to start it up.

5
The first time you start up, use the following procedure.

1. A dialog box saying “Welcome to FreeMIDI!” will appear. 
Click [Continue].

2. When the FreeMIDI Preferences dialog box appear.
Click [Cancel].

3. The About Quick Setup dialog box will appear.
Click [Cancel].

This unit is equipped with 
a protection circuit. A brief 
interval (a few seconds) 
after power up is required 
before the unit will operate 
normally.

For details on how to set 
the USB mode, refer to the 
“DR-880 owner’s manual.”

Once the connections have 
been completed, turn on 
power to your various 
devices in the order 
specified. By turning on 
devices in the wrong 
order, you risk causing 
malfunction and/or 
damage to speakers and 
other devices.

When “OMS is installed 

on this computer...” 
appears, click [FreeMIDI].
17
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6
From the File menu, choose Open. 

7
Select DR-880 from the FreeMIDI Setting folder you copied in step 3, and 
click [Open].

8
From the MIDI menu, choose Audition Channels.

The DR-880 dialog box will appear. Choose Use all Channels, and click 
[OK] to close the dialog box.

9
Verify that MIDI transmission and reception occur correctly.
From the MIDI menu, choose Check Connections.

fig.3-13_40

10
 Click the DR-880 icon shown in the 
diagram at the right. If you hear 
sound from the DR-880, the 
settings have been made correctly.

11
Once again choose the MIDI menu command Check Connections to end 
the test.

12
From the File menu, choose Quit to exit FreeMIDI Setup.

13
Make MIDI device settings on your sequencer software. 
Select the MIDI OUT/IN device to the BOSS DR-880.

If you are unable to select 
Open, make settings as 
follows. 
1. From the File menu, 
choose FreeMIDI 

Preference.

2. Uncheck “Use OMS 

when available.” 

3. Close FreeMIDI. 

4. Return to step 4 and 
continue the procedure.

For details on MIDI device 
settings, refer to the 
owner’s manual for the 
software you are using.

This completes the series of steps needed to connect the DR-880 to the 
Macintosh, install the MIDI driver, and make the driver settings.
18
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Mac OS X Users

■ Installing the driver

1
Disconnect all USB cables other than those for your keyboard and mouse, 
and restart your Macintosh.

2
Prepare the CD-ROM.

Insert the CD-ROM into the CD-ROM drive of your computer.

3
In the Driver (Mac OS X) folder of the CD-ROM, 
double-click DR-880USBDriver.pkg.

4
In the authentication dialog box, input the password and click [OK].

5
The display will indicate “Welcome to BOSS DR-880 USB Driver 
installation”.

Click [Continue].

6
If the display indicate “Important message,” read the contents and click 
[Continue].

7
The display will indicate “Select the location for installation”.

Click the drive in which the operating system is installed to select it, and then 
click [Continue].

8
The display will indicate “Easy installation”.

Click Install or Upgrade.

9
The display will indicate “Installing this software requires you to restart 
your computer when the installation is done. Are you sure you want to 
install the software now?”

Click [Continue installation].

10
The display will indicate “The software was successfully installed”.

Click [Restart] to restart your computer.

If the “Authernticate” 
dialong box appears 
during the installation, 
input the password and 
click “OK”.
19
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■ Setting the driver

1
Use the USB cable to connect the DR-880 to your computer.

* Before you connect the USB cable, you must first set the DR-880’s USB mode to 
“MIDI”, and switch off the DR-880’s power.

1. With the power switch turned OFF, connect the AC adaptor to the 
DR-880.

2. Connect the AC adaptor to an electrical outlet.

3. Use the USB cable to connect the DR-880 to your computer.

2
Set the DR-880’s power switch to the ON position.

3
Make MIDI device settings on your sequencer software. 
Select the MIDI OUT/IN device to the BOSS DR-880.

Cautions when using the DR-880
Before you use your sequencer software, please note the following points.

* Connect the DR-880 to your computer via a USB cable before you start up your sequencer or other 
software.

* Do not disconnect the USB cable from the DR-880 while your sequencer or other software is running.

* Disconnect the USB cable from the DR-880 only after you have quit your sequencer or other software.

* Leave the Sleep function of your Macintosh turned off.

* The DR-880 will not work in the Classic environment of Mac OS X. Use the DR-880 when the Classic 
environment is not running.

For details on how to set 
the USB mode, refer to the 
“DR-880 owner’s manual.”

Once the connections have 
been completed, turn on 
power to your various 
devices in the order 
specified. By turning on 
devices in the wrong 
order, you risk causing 
malfunction and/or 
damage to speakers and 
other devices.

This unit is equipped with 
a protection circuit. A brief 
interval (a few seconds) 
after power up is required 
before the unit will operate 
normally.

For details on MIDI device 
settings, refer to the 
owner’s manual for the 
software you are using.

This completes the series of steps needed to connect the DR-880 to the 
Macintosh, install the MIDI driver, and make the driver settings.
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Troubleshooting
Problems common to Windows and Macintosh

Problems occurring only in Windows

Problems occurring only in Macintosh

Cannot install the driver correctly
• Is the CD-ROM correctly inserted into your CD-ROM drive?

Installation is not possible unless the CD-ROM included with the DR-880 is inserted in your 
CD-ROM drive. Make sure that the CD-ROM is correctly inserted into your CD-ROM drive.

• Is the CD-ROM or the lens of the CD-ROM dirty?
If the CD-ROM or the lens of the CD-ROM drive is dirty, the installer may not work correctly. Clean 
the disc and/or lens using a commercially-available CD cleaner or lens cleaner.

• Are you installing the software from a networked CD-ROM drive?
The software cannot be installed from a networked CD-ROM drive.

• Is there sufficient free space on your hard disk?
Delete unneeded files to increase the amount of free space. After deleting the unneeded files, empty 
the recycling bin.

• Is the DR-880 connected correctly?
Make sure that the USB connector of your computer is connected to the DR-880 by a USB cable. 

• Is the power of the DR-880 turned on?

• The power switch of the DR-880 may have been set to the USB position.
Make sure that the power switch of the DR-880 is set to the DC position. Do not use bus power 
while installing the driver. Check this, and if you are using Windows, close the Sound and 
Multimedia Properties dialog box (Sounds and Audio Devices Properties in Windows XP, and 
Multimedia Properties in Windows 98), re-open the same dialog box once again, and specify the 
MIDI input/output destinations.

• Re-install the DR-880 driver as described in “Installing & Setting Up the Driver (Windows)” 
(p. 2). Also check whether there is any “Other devices” in “Device Manager” or “Unknown 
device” in “Universal Serial Bus Controllers”. If you find any, delete them.

• Is OMS or FreeMIDI installed?
In Mac OS 9, the DR-880 driver cannot be installed unless OMS or FreeMIDI are installed. Please 
install OMS or FreeMIDI. ( ➔ “Installing & Setting Up the Driver (Macintosh)” (p. 13))
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Troubleshooting
DR-880 is not detected when making OMS or FreeMIDI settings
• Is the DR-880 detected?

Turn the power of the DR-880 off, then on again.

Reconnect the USB cable.

If other USB devices are connected, connect only the DR-880.

It is possible that the Macintosh did not correctly detect and initialize the DR-880. Leave the DR-
880’s USB cable connected, and restart your Macintosh. If it is still not detected, shut down your 
Macintosh, and then restart it.

The DR-880 will not be detected if it is connected to the USB connector on the Macintosh keyboard.
Please connect the DR-880 to a USB connector on the Macintosh itself.

“Find new hardware wizard” does not execute automatically

The “Insert Disk” dialog box does not appear

“Find new hardware wizard” ends before the process is completed
• It may take about 15 seconds (or more) after the USB cable is connected for the DR-880 to be 

detected.

• Is the USB cable connected correctly?
Make sure that the DR-880 and your computer are correctly connected via a USB cable.

• Is USB enabled on your computer?
Refer to the operation manual for your computer, and make sure that USB is enabled.

• It has been found that in some cases, not all of the Windows 98 files required to support 
audio via USB are installed when a computer is shipped.
Please contact the manufacturer of your computer.

• Does your computer meet the USB specifications?
If you are using a computer that does not fulfill the electrical requirements of the USB 
specifications, operation may be unstable. In this case, you may be able to solve the problem by 
connecting a USB hub.
If the above actions do not solve the problem, it is possible that the DR-880 has been incorrectly 
detected by the computer. Please reinstall the driver from the beginning of the procedure. 
(➔“Installing & Setting Up the Driver (Windows)” (p. 2))

“Found unknown device” appears even though you installed the driver
If your computer or USB hub has two or more USB connectors, and you connect the DR-880 to a USB 
connector to which the DR-880 has never been connected before, the “Unknown device” dialog box 
may appear even on a computer onto which you have already installed the driver.
Refer to “Installing & Setting Up the Driver (Windows)” (p. 2), and install the driver once again. 
This is not a malfunction.

If the “Found unknown device” dialog box appears even though the DR-880 is connected to the 
same USB connector as before, it is possible that the computer has detected the DR-880 incorrectly. 
Please reinstall the driver from the beginning of the procedure. (➔“Installing & Setting Up the 
Driver (Windows)” (p. 2))
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Troubleshooting
An “Unknown driver found” dialog box appears, and you are 
unable to install the driver

Device Manager shows “?”, “!”, or “USB Composite Device”

Driver is not installed correctly
It is possible that the computer has detected the DR-880 incorrectly. Please reinstall the driver from 
the beginning of the procedure. (➔“Installing & Setting Up the Driver (Windows)” (p. 2))

Can’t install/use the driver in Windows XP/2000
• Did you log on to Windows as a user with administrative privileges?

In order to install/re-install the driver in Windows XP/2000, you must be logged into Windows as 
a user with administrative privileges, such as Administrator. For details, please contact the system 
administrator for your computer system.

• Did you make “Driver Signing Options”?
In order to install/re-install the driver, you must make “Driver Signing Options”. 
(Windows XP ➔ p. 2, Windows 2000 ➔ p. 6)

Windows XP/2000 displays a “Hardware Installation” or “Digital 
Signature Not Found” dialog box
• Did you make “Driver Signing Options”?

In order to install/re-install the driver, you must make the settings described in “Driver Signing 
Options”.
(Windows XP ➔ p. 2, Windows 2000 ➔ p. 6)
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